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Participant’s Manual 

General Overview 

 
Introduction This class includes explanations and activities designed to teach 

important IFAS topics.  Please feel free to ask questions at any time. 

 
Goals The following are the goals for today. 

 To log on and navigate through IFAS at your desk 

 To access reports that you need 

 

Use this manual for reference and completing exercises. 

 
Class 

Components 
There are three distinct parts of the class. 

 Introductions and Logging on 

 Using IFAS 

 Reports 

 
Contents  

Topic See Page 

Structure of Participant’s Manual 5 

Part 1:  Introductions and Logging On 6 

IFAS 101 Review 1 19 

Part 2:  Using IFAS 21 

IFAS 101 Review 2 31 

Part 3:  Reports 35 

IFAS 101 Review 3 49 

Glossary 51 
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Structure of the Participant’s Manual 

 
Introduction There are three parts to the manual.  Each part contains objectives that 

explain what you should be able to do at the completion of the section. 

 
Contents There are procedures, diagrams, tables or graphics, and review 

questions in this manual.  Please feel free to write notes or highlight 

important sections. 

 

A Glossary is provided.  Refer to the words during the class and at 

your desk, as needed.  The Table of Contents in the front of the 

manual lists topics and page numbers. 
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Part 1:  Introductions and Logging On 

Overview 

 
Introduction When asked, introduce yourself by name, identify your department, 

and rate your experience with Microsoft computer software by 

choosing a number from 1-10, with 10 being the highest rating.   

 

 
Information Administrative information includes vending, emergency exit, and 

breaks. 

 
Objectives The following objectives are covered in this section. 

 Define IFAS and its function. 

 Describe Insight and how it relates to IFAS. 

 Complete Insight logon procedures. 

 Describe procedures used for changing an IFAS password and tell 

why it would be necessary to do so. 

 

Continued on next page 
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Overview, Continued 

 
Contents of 

Part 1 
This part of the manual contains the following topics.  

 

Topic See Page 

The Function and Components of IFAS 8 

Insight 9 

The Shift Key Logon 10 

Changing Your Password 12 

Regular Logon 14 

Navigation in Insight 15 

IFAS 101:  Review 1 19 
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The Function and Components of IFAS 

 
Introduction IFAS is the software Harris County uses for its financial and 

administrative functions.  The acronym stands for Integrated Financial 

Administrative Solution.   

 

 
Modules IFAS is software that has been divided into large modules or sections 

to address the financial functions of the county.  These modules 

include Purchasing, Budget, Payroll, Employee Maintenance, and 

others.  If you have proper security clearance you can enter a module 

and work within it. 

 

The work you do in a module is saved and is then used for the 

financial and accounting mechanism of the entire county.  This ranges 

from adding new employees to issuing receipts.  The information that 

you enter into the system can be used to generate reports for your 

department and others. 

 

 
Tasks/ 

Functions 
Your work in an IFAS module is broken into tasks; for example, you 

may need to enter data into several screens in order to create a report 

for the new fiscal year budget. 

 

To carry out your responsibility, you need to know the IFAS system 

and how to navigate it.  The first part of this navigation is Insight. 
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Insight 

 
Introduction Insight is a graphical user interface (GUI, “gooey”) for IFAS. 

 

 
Point and Click IFAS allows you to use the Windows® standard method of 

navigating; that is, clicking on icons, tabbing, and typing in names to 

take you to the system. 

 
Passwords You must change your password every 60 days.  The system will warn 

you before the period elapses. 
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The Shift Key Logon 

 
Introduction The Shift Key Logon is one that is used in specific cases.  It allows 

you to choose the database you wish to use. 

 
Logging on 

(with the Shift 

key) 

Shift Key logon procedures are used in the following instances. 

 You have changed your password. 

 The system notified you to change your password. 

 You want to access a different database. 

 

The procedure is as follows. 

 

Step Action 

1 Click on the Start menu at the bottom left of your screen. 

2 Press the Shift Key and click on Insight on the Start Menu.  

Keep the Shift Key depressed until you see a dialog box 

that says, “Bi-Tech System Catalog Connection.” 

3 Release the Shift Key. 

4 Click on the database you want to use.  Syscat_prod is 

production.  Use Train for training purposes. 

5 Click the Select button or press Enter. 

6 In the OpenLink ODBC Login dialog box, type in your 

user ID (usually the first character of your first name and 

the first 7 characters of you last name).  Note:  Type the 

ID using lower case letters only.   

 

7 Tab and type in your new password.  Note:  Type the 

password using lower case letters only.  See Figure 1 

below.  Your password must have two numbers in it. 

 

 
Fig 1 

 
 

Continued on next page 
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The Shift Key Logon, Continued 

 
Logging on 

(with the Shift 

key) (continued) 

 

Step Action 

8 Press Enter or click the OK button. 

9 In the Insight “Connect to (database name)” box, enter the 

Password again in lower case letters.   

10 Press Enter on your keyboard. 
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Changing Your Password 

 
Introduction The following section gives you information about your password. 

 
Changing your 

password 
You must change your password before 60 days has passed.  If you 

don’t, it will expire.  In that case, you will not be able to access IFAS 

until Security re-issues a password to you. 

 

 
Procedure Do not share your password with anyone and never choose, “Save the 

Password” option when you logon.  Any work done under your 

password is your responsibility.  Saving the password at your 

computer will allow others to login under your user ID. 

 

Change your password prior to 60 days. 

 

The procedure for Changing a Password is as follows. 

 

Step Action 

1 Double-click the “Change IFAS Password” icon on your 

desktop.  The following box will appear. 

 

 
Fig. 2 

 

Continued on next page 
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Changing Your Password, Continued 

 
Procedure 

(continued) 
 

Step Action 

2 Type your user ID after “login.” 

3 Type your old password.  (Type in lower case letters only.)  

Press Enter.  All passwords must have 2 numbers in them.  

The total number of characters must be 6 at the minimum 

and 8 as maximum. 

4 When asked “Do you want to change your password,”  type 

y and press Enter.   

 

Note:  If you are changing your password because the 

system has prompted you to do so, a statement tells you 

that you must change your password.  Follow the 

prompt directions. 

5 Type in the old password.  Press Enter. 

6 Type in the new password.  Press Enter. 

7 Confirm the new password by typing it again.  Press Enter. 

8 A question will ask you, “Do you want to change your 

password?”  This time type n for no.  Press Enter. 

9 A message will appear saying that the “Host Lost.”  Click 

OK. 

10 Exit by clicking on X in the upper right corner of the 

screen. 

 

After you have changed your password, you must log on by holding 

down the Shift key while you click on Insight name.  Holding down 

the Shift key will bring up the Bi-Tech System Catalog Connection 

box listing the databases that you can access.  See the Shift Key 

Logon Procedures above. 

 

Continued on next page 
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Regular Logon 

 
Introduction After you have changed your password and logged in using the Shift 

Key Logon Procedure, you will use a Regular Logon Procedure from 

then on, unless you want to go into a different database.  The system 

recognizes your password and the database you want to work in. 

 
Logging on Follow these steps for a Regular Logon. 

 

Step Action 

1 Click on the Start menu at the bottom left of your screen. 

2 Click on Insight on the Start Menu. 

3 In the “Connect to (database name)” dialog box, your user 

ID will appear in the IFAS User field.   

4 a. If the user name is correct, tab to the IFAS 

Password field. 

b. If the user name is not correct, type the correct one 

in the field.  Tab to the password field.  Type the 

IFAS Password. 

5 Press Enter or click the Connect button. 

6 The Explorer view will appear with the IFAS menu tree.  If 

it does not appear, click the “house” button in the menu 

bar. 
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Navigation in Insight 

 
Introduction The following section defines how to navigate in Insight in order to 

get to IFAS functions. 

 
Navigating 

Insight 
There are two views in IFAS:  Explorer and Output.  Figure 3 shows 

the Menu Tree from which you select a module.  This is called the 

Explorer view. 

 

 
Fig. 3 

 

By opening modules and sub-modules, you navigate to the “functions” 

or tasks you need.   

 

There are three ways to get to the task you need:  1) through the Menu 

tree and 2) by entering a mask which is a code typed into the empty 

field on the right, the Type Ahead History Box.  3)  by clicking on the 

drop down box on the Type Ahead History Box and selecting from the 

listing of previously used masks.  The mask usually consists of the 

first two characters of the module, sub-module and letters from the 

function.  Clicking on a - sign will close that level in the directory 

tree. 

 

Continued on next page 
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Navigation in Insight Continued 

 
Menu Scheme 

Field 
The Menu Scheme field is on the left of the Type Ahead/History field 

and lists the names of any menu schemes that you have used.  See the 

Using Options section. 

 
The Menu Tree 

- Explorer View 
 

 
Fig. 4 

 

To get to a task by using the Menu tree, simply click on the + sign that 

precedes the name of module and sub-module.  Then, select the 

function (task) by double-clicking on it.  In Figure 4 above, the Client 

Specific module is opened, the User Department Requisitions sub-

module is opened, and the Create/Update Requests function is 

selected.  Double-clicking on this function takes you directly to the 

IFAS screen.   

 

Continued on the next page 
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Navigation in Insight, Continued 

 
Masks If you wanted to use a mask for the task in Fig. 5, enter CSUDRQ in 

the Type Ahead History Box.  This means you are requesting the 

Client Specific module, the User Department Requisitions sub-module 

and the Create/Update Requests function.  

 

  
Fig. 5 

Just as Microsoft has an hour clock that shows up while it is busy, 

IFAS displays a spinning logo while it is working.  The icon is an 

abacus, an instrument used for mathematics.  It spins when the system 

is busy retrieving or storing data. 

Continued on next page 

Enter Masks here. 
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 IFAS 101:  REVIEW 1 

 
Introduction Write the answer to these review questions in the space provided. 

 
Passwords 1.  When you enter your password, why is it important to make sure 

that your CAPS LOCK is disabled? 

 

 

2.  What is the minimum and maximum character length for an IFAS 

password?  

 

 

3.  Why should you never use the “Save Password” option when you 

logon to IFAS? 

 

 

4 . Why should you never share your password? 

 

 

5.  When do you have to change your password? 

 

 

6.  If the system prompts you to change your password while you are 

in a session, what should you do? 

 

 
Insight 

Navigation 
7.  What is a mask? 

 

 

8.  What happens when you click the + sign that appears to the left of 

a module icon?  The - sign? 

 

 

9.  What does it mean when the Bi-Tech logo spins? 

 

Continued on next page 
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IFAS 101:  REVIEW 1, Continued 

 
Answers: 

Passwords 
1.  The Cap Lock must be disabled because both the User ID and the 

password require lower case letters.  Without lower case, the system 

will not recognize you. 

 

2.  The password must be between 6 and 8 characters in length and it 

will accept both alpha and numeric characters. 

 

3.  Never use the “Save Password” option because it allows others 

access the system in your name. 

 

4.  Never share your password because anything done using your ID 

and password will be your responsibility. 

 

5.  You change your password before 60 days has passed.   

 

6.  You can change your password while in an IFAS session when the 

system prompts you.  However, this password is valid for only one 

hour.  It is best to exit the session as soon as you are prompted and do 

so via the desktop. 

 
Answers: 

Insight 

Navigation 

7.  A mask is a set of letters that are made up of the first two letters of 

the items within the Insight Menu Tree that are grouped together.  A 

mask will have a minimum of 4 characters if no sub-module is 

specified. 

 

8.  When you click the + sign before a module or sub-module, the item 

is opened to expose sub-modules or functions. 

 

9.  When the Bi-Tech logo spins, the system is busy. 
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Part 2:  Using IFAS 

Overview 

 
Introduction  There are two screens that you use in the IFAS program; these are 

Data Entry and Triad.  You enter data in each type. 

 

 
Objectives The following are objectives covered in this section. 

 Identify the two types of screens in IFAS. 

 Explain the IFAS Data Screen Modes and their function keys. 

 Identify the TRIAD Screen Modes and their function keys. 

 Create a record. 

 Define GL and JL account codes. 

 Explain how to locate records. 

 Identify two options you have in IFAS. 

 

 
Contents of 

Part 2 
This part contains the following topics. 

 

Topic See Page 

Output View 21 

IFAS Data Entry Screen 22 

Triad Screen 24 

Creating a Record 25 

Using Options 27 

Review 2 32 
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Output View  
 
The Output 

View 
A second view you have into IFAS is the Output view, seen in Fig. 6.  

Go to it by clicking the new page icon  in the menu bar.  The 

Output view gives general information. 

 
Fig. 6 
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IFAS Data Entry Screen 

 
Introduction This section gives information about the Data Entry Screen and its 

use. 

 
Characteristics 

of the IFAS 

Data Entry 

screen 

There are two types of screens in IFAS:  IFAS Data Entry and the 

TRIAD screen.  You can determine which type of screen you are 

viewing by the navigation tool that is displayed.  The IFAS Data Entry 

screen uses the following toolbar to navigate. 

 

 
Fig 7 

 

Anytime you see this toolbar in the menu bar at the top of the screen, 

you know that you are on an IFAS Data Entry screen.  These 

individual buttons are linked to function keys that you may also use 

while in this screen.  In addition, there are two modes of actions in this 

screen. 

 

 Collect  allows you to enter new records into the database. 

 Browse  allows you to: 

 Update a record 

 Maintain or change a record 

 View a record (by “paging” through) 

 Delete a record 

 

You can also use function keys, instead of the toolbar. 

 

Continued on next page 
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IFAS Data Entry Screen, Continued 

 
Function keys 

for IFAS Data 

Entry screens 

 

The following diagram gives you the controls (F keys) for the 

operations in Data Entry Screens. 

 

 
Fig. 8 

 
Searching When you search for an item in the Browse Mode, use the @ for the 

IFAS Data Entry screens as a wildcard.  This symbol will yield 

anything that contains the letters that preceded or followed it.  When 

searching for a name in the selection criteria dialog box, use * as the 

wildcard. 
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Triad Screen 

 
Introduction This section give you information about the Triad Screen and its use. 

 
Characteristics 

of the TRIAD 

screen 

The Triad screen contains this navigation bar. 

 

 
Fig 9 

 

The middle rectangle denotes the mode you are currently in. 

 

There are three modes of operation for the Triad screen. 

 

 Add is where you enter new records into a database. 

 Browse allows you to: 

 Update records 

 Maintain or change a record 

 View a record 

 Delete a record 

 Select allows additional search or query options. 

 

 
Function keys 

for TRIAD 

screens 

The following diagram gives you the controls for the operation of the 

Triad Screen. 

 

 
Fig. 10 
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Creating a Record  

 
Introduction This section covers how to create a generic record in IFAS. 

 
General 

Procedures for 

Creating a 

Record 

Here are some things to remember when working in IFAS. 

 

 To move between fields, use the Tab key and the four arrow keys.   

 To save your record, press Enter. 

 Watch the bottom left-hand corner of the IFAS screen for messages. 

 Type in the alpha character mask in the upper right field on the 

Explorer screen to display your screen quicker. 

 

Continued on next page 
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Creating a Record Continued 

 
Account Codes:  

GL 
The following figure gives you the criteria for an Org Key and an 

Object Code. 

 

 
Fig. 11 

 
Account Codes:  

JL 
The following figure gives you criteria for the JL Key and the JL 

Object Code. 

 

 
Fig. 12 

 
Practice Follow the instructor’s directions to create a record.  Use the data 

provided. 
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Using Options  

 
Introduction The section that follows gives you a way to customize your IFAS 

work space.  Menu schemes are an assortment of favorite functions or 

tasks.  Following these procedures will allow you to access them 

quickly through a button on the toolbar, a shortcut key that you 

specify, or a menu item.  These options will take you immediately to 

the function that you specify. 

 
Menu Schemes With a menu scheme, work is faster than using a Mask or the Menu 

Tree.  It allows you to insert a customized menu name in the menu bar 

of the application.  When you click it, it takes you to the function you 

specified. 

 

A menu scheme is optional, but it can improve your efficiency. 

 

Procedures to create a menu scheme are as follows. 

 

Step Action 

1 With a function selected, choose the Edit menu 

option from the IFAS Explorer view. A dropdown 

list opens. 

2 Choose the Customize option from the dropdown 

list.  The Select dialog box opens.  This box 

displays all current menu schemes and their user 

names. 

 

Note:  If you have a menu scheme selected when 

you start this procedure and the General dialog 

box appears, you must click the Back button twice 

to get to the Select dialog box. 

3 On the Select dialog box, click the Add button 

 in the upper part of the box. The Advanced 

dialog box opens. 

4 Click the Other users may use this menu option. 

Note: This options means that other users can use 

this menu scheme, but they cannot change it. 

5 Click the Next button at the bottom of the box. 

The General dialog box opens with the Menu 

Scheme field at the top. 
 

Continued on next page 
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Using Options, Continued 

 
Menu Schemes 

(continued) 
 

6 
Click the Add  button, the new page icon, in 

the upper part of the box.  Choose Add Favorites.  

The Properties dialog box opens. 

7 Type your first name in the Description field (this 

will be the menu item you see in the menu bar) 

and click OK. The General dialog box is visible.  

You have just completed the menu item scheme. 

To finish, click Finish.  To associate an icon to the 

function, continue this procedure. 
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Using Options, Continued 

 
Menu Schemes 

continued 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8 Click the new page icon. 

 

9 Choose the Add Favorites option from the 

dropdown list.  

10 Click the Change Icon button in the Favorite 

Properties dialog box to choose an icon to 

connect to your shortcut. The Change Icon dialog 

box opens. 

11 Choose an icon from the list of options. 

 

Note: You cannot use the following three icons. 

 Bi-Tech icon 

 Bi-Tech logo icon 

 Running Man 

 

12 Click the OK button to save your choice. The 

program returns to the Favorite Properties dialog 

box.  Choose the icon you want to display.  Click 

OK. On the Favorite Properties box, choose the 

function that you want to associate with the icon.  

The name of the function appears in the 

Description field.  Click OK.  On the General 

dialog box, click Finish. 

 

You have just associated an icon to the function.  

When you are finished, cancel out of the dialog 

boxes.   

 

Continue for setting a control key. 

 

 

13 From the General dialog box, click the Add icon 

near the top of the box.  Click Add Favorite.  

Choose the function in the directory tree that is 

visible. 

 

Click the Set Shortcut Key option in the Favorite 

Properties dialog box to assign a shortcut key. 

The Assign Shortcut dialog box opens. 
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14 Type a letter in the Press new shortcut key field. 

Both the Ctrl + and the letter appear in the field. 

 

Note: If the message under Current Assignment 

says anything other than Unassigned, you must 

choose another letter. 

15 Click the OK button. The program returns to the 

Favorite Properties dialog box. 

 

Note: The shortcut key you created appears in the 

Shortcut Key field. Even though it is grayed-out, 

the key is still valid. 

16 Click the OK button. The program returns to the 

General dialog box, which shows the icon you 

selected. 
 

  

17 Click the Finish button. The IFAS Explorer view 

opens showing the icons you added.  You may test 

the control key that you created (it will bring up 

the first screen of your function).  You will see the 

name that you assigned to the function. 
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Using Options, Continued 

 
Practice Use the following to complete the exercise based on the instructor’s 

directions.   

 Allow others to derive from your menu. 

 Create a menu scheme using your last name. 

 Create a menu description using your first name. 

 Select a function from the menu tree to use as a favorite.  Create a 

shortcut key and leave the default icon. 
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IFAS 101:  REVIEW 2 

 
Introduction Write the answer to these review questions in the space provided. 

 
Insight 1.  What important information is found in the title bar of Insight? 

 

 

2.  Where is the Type Ahead/History box located? 

 

 

3.  What is the function of the Type Ahead/History box? 

 

 

4.  In what ways can you switch between the Explorer and Output 

views? 

 

 

5.  Explain how to open a function (task) by navigating the Insight 

Menu Tree. 

 

 

6.  How can you access a previously used mask? 

 

 

 

 
TRIAD 7.  How do you know if you are in a Triad screen? 

 

 

8.  How do you know which mode you are in on a Triad screen? 

 

 

9.  Which keys should be used to move between fields? 

 

 

10.  Which key is used to save information? 

 

 

 

Continued on next page 
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IFAS 101:  REVIEW 2, Continued 

 
TRIAD 

(continued) 
The following figure is a diagram of Triad screens function keys. 

 

 
 

Function Keys 11.  What is F7 used for in the Triad data-entry screen? 

 

 

12.  What does F6 do in Add mode?  In the Browse mode? 

 

 

13.  What does F5 do in Add mode?  In the Browse mode? 

 

 

14.  What does F4 do in a Triad screen? 

 

 

15.  How should one navigate in the Triad mode? 

 

 

16.  What mode can you save information in the data fields?  What 

key do you use to save? 

 

 

17. What function key allows you to use a pick list? 

 

 

Continued on next page 

MODE 

ADD 

BROWSE 

F1 

help 

help 

F2 

n/a 

delete 

F3 

options 

options 

F4 

screen 

screen

n 

F5 

previous  
screen 

previous  
record 

F6 

next 
screen 

Next 
 record 

F7 

browse 

add 

F8 

exit 

exit 
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IFAS 101:  REVIEW 2, Continued 

 
Account Code 

Structure 
What do the first three characters of the GL key represent? 

 

 

What characters represent the department number in a GL Key? 

 

 

Which of these does the GL key define? 

Who  

What 

When 

Where 

Why 

 

 

On a GL Object Code, what do the first four characters identify? 

 

 

What does a JL code identify? 

 

 

 

Continued on next page 
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IFAS 101:  REVIEW 2, Continued 

 
Answers:  

Insight 
1. The name of the database you are working in. 

2. It is on the right hand side above the directory tree. 

3. The function of this box is to bring up the mask that you enter. 

4. Press the “page” button. 

5. Press the + on each directory until you get to the name of the 

task you want to complete. 

6. Use the drop down arrow next to the Type Ahead History box. 

 
Answers:  

TRIAD 
7. The triad menu bar appears. 

8. The center button on the triad menu bar tells you the mode you 

are in. 

9. The arrow keys should be used to move. 

10. The Enter key saves the record. 

11. The F7 toggles between the browse mode and the add mode. 

12. F6 in the Add mode brings up the next screen.  In Browse, it 

brings up the next record. 

13. F5 takes you to the previous screen in both the Add mode and 

the Browse mode. 

14. describes the screen or data field 

15. Use the arrow keys and tab. 

16. Save information in the Add mode.  Enter saves. 

17. The F1 key takes you to a pick list (help) 

 
Answers: 

Account Code 

Structure 

18. The first 3 numbers represent the Fund number. 

19. The department number is the second three numbers. 

20. GL defines who and what. 

21. Account number 

22. Why and Where is communicated by the JL codes. 
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Part 3:  Reports 

Overview 

 
Introduction IFAS includes several types of reports.  

 File Listings 

 Standard Reports 

 Client specific Reports (Click, Drag and Drill reports)  

 Ad Hoc Reports. 

 
Objectives  The following objectives are covered in this section. 

 Navigate to File Listing reports 

 Describe the function of the Account Transactions report. 

 Be familiar with at leas five of the classifications of File Listing 

reports. 

 
Contents  

Topic See Page 

Standard Reports 36 

File Listing 37 

CDD Reports 43 

Exporting CDD Reports to Excel 45 

Review 3 50 

Glossary 52 
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File Listing 

 
Introduction These reports represent reports with the Object Codes currently held 

in the General Ledger (GL) database. 

 

 
Key 

Information 
Complete the following procedure to choose a report. 

 

Step Action 

1 From the Menu Tree, select GL: General Ledger 

2 Select RE:  Report 

3 Double-click GL Database File Listing 

4 You will see fourteen types of reports to choose from 

 

One of these reports is Account Transactions.  This report details 

transactions for Object Codes within the Org. Keys.  The user defines 

date ranges.  This report will display text detail associated with the 

transactions.  If you choose to display text detail, it will be displayed 

every time the reference or job number changes. 

 

The following classifications represent the File Listing report formats. 

 

Continued on next page 
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File Listing, Continued 

 
Key 

Information 

(continued) 

 Common Codes (CO) - This reports NUCLEUS, Common Code 

definitions.  The system requires you to enter the Common Code 

Categories to be listed 

 Default Account Mapping (DF) - Data allows for the mapping of GL 

or JL defaults. 

 General Information (GN)  This reports the GL General Information 

created through GLUPGN. 

 Organization Key Information (KY)  This reports the details defined 

for each organization key crated through GLUPKY.  A long or short 

format is available.  Selection criteria and a sort function are 

provided. 

 Object Code Information (OB)  This reports gives the details defined 

for each object code created through GLUPOB.  A long or short 

format is available.  Selection criteria is provided. 

 Object Group Codes (OG)  This reports the Object Group codes and 

defined titles.  Selection by Object Group is provided. 

 Organization Part Codes (PT)  This reports the Organization Part 

codes and titles that have been defined.  Selection by Organization 

Part is provided. 

 Quick account numbers (QU)  This reports the Quick Account 

Numbers defined and associated organization key and object code. 

 Rule Logic for Key Creation (RU)  This classification reports the 

Rule Logic defined which controls the proper association of Org 

Parts to Org Keys 

 Subsystem Interface (SI)  This reports the Subsystem Interface 

definitions and all associated relationships between GLUTSPSI, 

GLUTSPPP, FDID, CKID, GLUTSPSC, and GLUTSPPM..  It 

checks to see if there are any undefined parameters.  Selection 

criteria are by Ledger, Subsystem ID or Subsystem Register. 
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Standard Reports 

 
Introduction This section gives you basic information for creating standard reports. 

 

 
The Basics To access the Standard Reports, follow these steps. 

 

Step Action 

1 Click on General Ledger plus sign on the Insight Menu 

Tree. 

2 Select RE: Reports. 

3 Double-click Standard Reports. 

4 Choose a report. 

 

Note:  Harris County generally uses CDD reports rather than the 

Standard Reports covered here.  Report Definition Files (RDF) 

are not used. 
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Standard Reports Continued 

 
Selection 

Criteria 
The first item for selection is the Ledger that you want to use, the 

General Ledger or the Job Ledger.   

 

You may select: 

 Type of Selection Criteria you want reported.  You may choose 

more than one.   

 The fiscal year 

 The printing criteria.   

 The starting and ending transaction dates. 

 

 
Fig 14 

 
Selection 

Criteria  
Note:  If no selections are made, all items for the selected ledger 

will be reported.  This will generate hundreds of pages.  Always 

limit your search by choosing selection criteria. 
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Standard Reports Continued, Continued 

 
Types More than one type of selection criteria may be selected. 

 To see a range of object codes within a specific fund, click on both 

the Organization Key and the Object Code. 

 To see a specific batch of transactions distributed to a range of 

object codes, click on Object Code and Transaction. 

 
  

 
Fig 15 

 

Figure 15 shows the criteria that you can choose for File Listing.  

Enter the ledger, type of selection criteria, the date range, the format, 

and sort levels. 

Continued on next page 
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Standard Reports Continued, Continued 

 
Types 

(continued) 
If a “Type of Selection Criteria separated by commas” is selected, a 

menu option appears on the screen to show the criteria available based 

on the selection Type.  This narrows the search to individual values or 

a range of values.  These criteria include the Org Key, Location, and 

Transaction Data.  For example, if the HC Object Code is checked, 

Selection Criteria for the Object Code appears so that individual 

criteria are reported. 

 
Sort Order In Fig. 15, note the bottom section dealing with order.  The sort option 

provides the capability to group data in difference orders.  When 

filling out the sorting section, there may be one to eight levels of 

sorting.  If a sort order is not specified, a default sort order will be 

used. 

 

You can also specify where you want Page Breaks to occur. 
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CDD Reports 

 
Introduction CDD reports are named for the Click, Drag, and Drill features.  To 

access these reports, either click the blue running man icon in the 

toolbar or choose CDD reports at the end of the Menu Tree.   

 

A listing of reports will appear for you to select from.  Click the + sign 

in front of the titles to open the exact report you want. 

 
Report titles Reports show by description by default (see Fig 16).  If you want to 

change the way the reports are listed , right click in any white area of 

the dialog box.  Choose “Show Name and Description.” 

 

 
Fig 16 

Continued on next page 
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CDD Reports, Continued 

 
Report titles 

(continued) 
The following shows the Name and Description listing for Fig. 17. 

 

 
Fig 17 

 
Output To change the output method, click the down arrow for the Output 

button to the left of the name field.  It displays the current output 

choice.  You can have the output go to the screen, to the printer, or to 

an electronic file. 

 

Step Action 

1 Click the Output button down arrow.  Note that the chosen 

file is no longer highlighted. 

2 Click the Output button once. 

3 A Prompts box appears for you to add the search criteria. 

 

Note:  When printing a large report, print pages 1-10 first and see 

how long it takes.  You may continue by printing in small 

increments (up to 50 pages at a time).  If you have multiple 

divisions in your department, request the report by division 

rather than your department.  That may make the print job go 

faster. 

 

Output button 
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Exporting CDD Reports to Excel 

 
Introduction Before you start this process, run the report in IFAS to be sure that 

you have selected the desired data. 

 
Procedure Follow this procedure to export a CDD report to Excel. 

 

Step Action 

1 Click the running man  in the toolbar. 

2 The Open and Run dialog box opens. 

3 Select File as output method. 

4 Double-click the report you want to run.  The selection 

criteria (Prompts) dialog box appears.   

5 Enter the desired criteria and click OK.  The Export to File 

dialog box appears. 

 

 
Fig 18 

6 Accept the default Export type as Tab (delimited).  Click 

the Browse button to specify the location and file name. 

  

Continued on next page 
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Exporting CDD Reports to Excel, Continued 

 
Procedure 

(continued) 
 

7 Choose the regions that you want to exclude from the 

report.  All regions are included as a default.  Clicking on 

the checkbox will uncheck the item. 

8 Click OK. 

9 In Excel, select File > Open.  Change the Files of Type to 

Text Files.  Specify the location where you saved the CDD 

text document. 

 

 
 

Fig 19 

 

Continued on next page 

Text Files 
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Exporting CDD Reports to Excel, Continued 

 

 
Procedure 

(continued) 
 

10 Select the name of the file created from the CDD report. 

11 Click Open.  The Text Import Wizard opens. 

 

 
Fig 20 

 

12 Select Delimited. 
 

Continued on next page 
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Exporting CDD Reports to Excel, Continued 

 
Procedure 

(continued) 
 

13 Click Next.  Screen 2 of the Wizard lets you preview the 

data selected for import.  You can see the general format in 

the table at the bottom of the dialog box. 

 

 
Fig 21 

 

Continued on next page 
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Exporting CDD Reports to Excel, Continued 

 
Procedure 

(continued) 
 

14 The final step is the column data format.  Scroll through the 

data to view the format selected.  To change the format, 

click the desired radio button.  You will see the format 

change for each format in the Wizard. 

 

 
Fig 22 

 

 
In Excel With the CDD report in Excel, you can resize any column or cell to 

accommodate data.   Note:  Excel will default to the portrait 

orientation.  Switch to landscape for easier reading.   

 

To get the best hard copy of your report, follow these steps. 

 

Step Action 

1 Click the Print Preview icon on the toolbar. This gives a 

view of what the document will look like after printing. 

2 Click the Setup button.  Change the orientation from 

Portrait by clicking the Landscape radio button. 

3 Under Scaling options, click the Adjust to radio button and 

start at 70% and increase the number until all columns are 

on the same page.   

4 You may change margins by clicking File > Page Set up > 

Margins. 

  

 

 

Column Data 

Format 

Column Data 

Format 
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IFAS 101:  REVIEW 3 

 
General 

Information 
1.  File Listing Reports represent __________   ___________ held in 

the General Ledger database. 
  
 2.  True or False  Report Definition Files (RDF) are not used in Harris 

County. 
  
 3.  True or False  Without specified selection criteria, reports can be 

hundreds of pages long. 
  
 4.  CDD reports are named for: ___________ __________ and 

___________ 

 
CDD reports 5.  How do you change the output method of a CDD report?  What 

options do you have for output methods? 
  
CDD Reports 

to Excel 
6.  In the Text Import Wizard of Excel, when you are importing a 

CDD report, what file type do you designate as describing your data? 
  
 7.  Remember to switch the orientation of the Excel report from 

_____________   to _________________. 
  
File Listing 8.  What do you do to see a range of object codes within a specific 

fund? 
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Review Answers 

 
General 

Information 
1.Object Codes in the General Ledger database 

 

2. True 

 

3. True 

 

4. Click Drag and Drill 

 

5. Click the Screen button to the right of the name filed.  Options are 

Screen, Printer and File. 

 

6. Delimited 

 

7. portrait to landscape 

 

8. To see a range of object codes within a specific fund, click on both 

the Organization Key and the Object Code on the Insight dialog box 

in Standard Reports under RE:  Reports under General Ledger in 

the Insight menu tree. 
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Glossary 

 
Explorer View Similar to Windows® Explorer; it is used to access the functions of 

IFAS through the Insight Menu Tree and masks 

 
Functions Various data entry screens, interactive inquiries and reports found 

within the Modules 

 
IFAS Integrated financial Administrative Solutions 

 
IFAS Screens IFAS data entry screens that are used for updating the selected 

database;  interactive inquiry screens are used for getting information 

from the database; CDD report screens are used for viewing 

information on reports. 

 
Insight The graphical user interface (GUI) for IFAS 

 
Menu Scheme A collection of functions that can be accessed from either a shortcut 

key, a tool bar button or a word in the menu bar. 

 
Modes The means of determining what you can do with data while in a 

particular Triad or IFAS data entry screen 

 

In the Triad screen, there are three modes: 

 Add - used to enter new data into the system 

 Browse - used to edit what was entered in the ADD mode 

 Select - used to search for a particular record or data entry 

 

There are two modes available in the data-entry screens: 

 Collect - used for entering new data into the system 

 Browse - used to edit what was entered in the Collect mode 
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Glossary, Continued 

 
Modules The major components of IFAS found on the Insight Menu Tree; the 

title with the icon that looks like a filing cabinet 

 
Output View A record of activity done in IFAS until log off; it is in this view that 

you can input data, perform interactive inquiries, and run reports 

 
Pick List A listing of all data that can be entered into a particular field 

 
Selection 

Criteria 
Names or descriptions that are entered in a Prompts box for a CDD 

report.  They limit the results of a search of the database by retrieving 

only the specified descriptions. 

 

 
Shortcut Key The Control key plus the letter that you have designated in the Menu 

Scheme Option 

 
TRIAD Truly Relational Integrated Application Developer; special software 

 
Wildcard 

symbol 
In the Triad screen, it is @;  the system will search the database for 

the data part that you entered before or after this symbol 

 

 


